
We don’t have all the details yet – but it’s time to make an announcement 
as we’re doing this mid-October!!

Microsoft’s Most Valuable Professionals, or MVPs, are technology 
experts who passionately share their knowledge with the community.  
They are always on the “bleeding edge” and have an unstoppable urge 
to get their hands on new, exciting technologies.  

How much would you be prepared to pay for the likes of Excel (and 
other) MVPs, Microsoft staff and other industry experts to present on a 
variety of Excel topics in your house?

Well, it’s an option.  For a third successive year, our usual Excel Summit 
South will not be held this year due to the current worldwide logistics.  
But again, we won’t be beaten.  We’ll just go even bigger.  And even 
better.  And, er, even more global.  And cheaper.  And it’s for charity.

This virtual conference, presents Excel, Data Platform and PowerPoint 
MVPs and other experts, together with other acknowledged experts 
from Microsoft and / or around the globe to present, answer questions 
and demonstrate the future of Excel and how it will make your life easier, 
personally and professionally.

Topics and presenters have not yet been agreed, but you know the drill!  
We’ll round a few up and get them to entertain you.  Dates will be in 

the week commencing Monday 17 October 2022, with precise dates and 
times to be announced SOON.

Each session (including Q&A) will last no more than an hour and topics 
cover all expertise levels, from novice to expert.  Most presenters are 
well known in their spheres, and have written blogs, books and articles 
and / or present video sessions.

Most sessions will be recorded so you may watch them later with 
downloads aplenty – there are no medals for staying up to watch the 
entire event live!  That’s just as well, as we plan to beat last year’s 
marathon (no guarantees), which lasted a “mere” 60 hours.  And it 
nearly killed us!  face-smile-beam

From your own favourite chair, bring a laptop, an inquisitive mind and 
your sense of humour.  Be prepared to learn heaps.  And remember, it’s 
not just value for money, we will be asking for donations to charity this 
time around – all profits will be donated to a global COVID-19 research 
charity.

More details will be available in the News section of our website soon: 
www.sumproduct.com/news.

Hopefully, we’ll see you there!
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Liam Bastick, Managing Director, SumProduct

Excel Virtually Global 2022

Excel’s not dead! In fact, it’s Live – Excel Live – and we detail how below.  As Microsoft focuses more and more 
on collaboration, Excel moves ‘next gen” on interactive access.  And talking of interactive, we also reveal details on no less than TWO 
upcoming summits!

We also provide you with another Beat the Boredom Challenge to keep your Excel brain nimble, and complement this test with articles 
on Charts & Dashboards, Visual Basics, Power Pivot Principles, Power Query Pointers and Power BI Updates.  We 
finally get to the end of our imaginary Excel functions series too, although our focus on CTRL + SHIFT keyboard 
shortcuts appears to continue unabated (how would you “function” without  them..?)!

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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Given how many of us work remotely some or all of the time, collaboration 
online is becoming more and more important.  Last year, Microsoft 
introduced PowerPoint Live, which assisted presenting in Microsoft 
Teams.  This year, at the recent Microsoft Build 2022, Live Share was 
introduced into Public Preview, which provides developers with the 
opportunity to take third-party apps beyond passive screen sharing and 
enables participants to jointly watch, edit and create in Teams.

Until now, sharing spreadsheets within a Teams meeting has been 
a case of “one person presents, the rest watch”.  Now, it’s possible 

to collaborate.  Microsoft has announced an enhanced collaboration 
solution for working on Microsoft Excel workbooks, called Excel Live, to 
allow your colleagues and you to collaborate in real time within your 
Teams meetings.

To use it, simply click the Share tray in Teams and scroll down to ‘Excel 
Live’, where you’ll see a list of your recent Excel workbooks.

Then, select the workbook you want to share.  You’ll be asked to share access to the file with meeting participants.  Choose Share.

After sharing access, everyone in the meeting can now edit the Excel file directly from the meeting screen in Teams.

Introducing Excel Live
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The Teams meeting window now becomes a canvas for all participants to 
work together.  Participants can follow the presenter, interact and edit 
the workbook, without ever leaving the meeting screen.  You don’t even 
need to have Excel running on their device.

This may also be accessed from within Excel for the web.  For example, if 
you have a workbook open that you want to share in a Teams meeting, 
just click Share, then Work together in Teams. 

You may want to look at the data your way, while working together, so 
Excel Live supports Sheet Views, which allows everyone co-editing the 
workbook to create customised views to sort or filter information however 

needed (without disrupting anyone else’s view).  The workbook loads for 
each participant at the optimized zoom level with flexibility to adjust zoom 
based on their preferences.  You’ll be able to set permissions or use ‘Show 
changes’ to double-check the edits that were made during a call.

Excel Live will be available in Public Preview at the end of August.

If you are unsure of how to get such a Preview:

 • IT administrators need to set an update policy that turns on Show  
  preview features
 • users then choose to join the Public Preview individually. 

On September 5, 8 and 9, SumProduct’s Liam Bastick will be presenting 
at the next big Excel virtual event (https://mydatasummit.com/) on the 
topics of  Financial Modelling in Power BI and Best Practice Financial 
Modelling (in Excel - not boring, we promise!!) with lots of cool tricks to 
make your life easier.

You can make sure you get your ticket for My Data Summit 2022 and 
use coupon code LIAM-10 (if only that were my age!) at checkout  
[https://lnkd.in/gZ4tDT98] for 10% off the event ticket and masterclasses. 

My Data Summit 2022 features keynote speakers from Microsoft, 
presentations by 33 experts and nine [9] masterclasses.  The presentations 

and classes will cover Microsoft Excel and Microsoft Power Platform 
topics.  The sessions will be recorded so you can catch those you miss or 
want to watch again!

The Summit runs from September 5th through September 7th, and 
Masterclasses will take place on September 8th and 9th.  Don’t miss 
out on this opportunity to improve your skills in both Excel and Power 
Platform. Register today!

Check out the My Data Summit 2022 agenda here: https://lnkd.in/
gvZQ5u-t .

My Data Summit
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With many of us currently “working from home” / quarantined, there are 
only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance 
in blood pressure millimetres of mercury (mmHg).  To try and keep our 

readers engaged, we will continue to reproduce some of our popular  
Final Friday Fix challenges from yesteryear in this and upcoming 
newsletters.  One suggested solution may be found later in this newsletter.  
Here’s this month’s…

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we look at data 
ranges and data tables for charts.

This month’s challenge can be answered using the new function TEXTSPLIT (albeit not yet available in all versions of Excel), Power Query or by using 
Text to Columns in seconds.  But that’s not what we want here.  The aim is to find a formulaic solution that may be used in all versions of Excel.   
That’s a little trickier…

Beat the Boredom Challenge

Charts and Dashboards

They say sometimes the most complex problems are those that take only 
moments to communicate.  If that’s true, then this month’s challenge 
might cause some fun and games!

“All” I want to do is take a text string and split it up so that each element 
of text is split into a separate column formulaically, e.g.

A data range is simply a set of data that has been organised in a certain way for it to be converted into a chart, viz.

In general, good chart data is data that is structured in such a way that is easy to construct the consequential chart.  For instance, to create a Bar 
chart, data would be best organised in a continuous range of cells:

The table above will produce the following graph:

Note I have used different separators (delimiters) in the two examples displayed.  The fact I have used four elements each time is entirely coincidental.

This month’s challenge is “simply” to come up with a formula that will produce the desired results.

Sound easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!

The Challenge

Data Ranges
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The following image is still considered a data range; it is just not formatted:

Now to be clear the data is neither dirty nor bad.  The data is just in a format that is not in a favourable format when creating a chart, e.g.

Charts may be built with a data table displayed within the chart.  The ‘Data Table’ option may be enabled through selecting the chart:

Data Tables
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Navigate to the Design tab on the Ribbon and then select the ‘Add Chart Element’ option in the ‘Chart Layouts’ group:

This will bring down a dropdown menu where I can select the ‘Data Table’ option.

We may then opt to have a Data Table with or without legend keys.  In the example below, we have opted to include legend keys so that it is easier 
for the end user to understand:
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Data Tables are an important tool to have in your toolkit while producing dashboards.  Data Tables represent another useful way to show how 
different scenarios will play out when flexing certain key inputs.  When you have one input to flex you can simply use a one-dimensional table.

More next month…

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.  This 
month, we consider or While Wend loops.

Last month, we looked at For Each…Next loops.  Therefore, it makes sense to spend “awhile” with While Wend loops this time.  The syntax is very 
simple:

While condition

    [statements]

Wend

The condition must result in a Boolean value of True 
or False.  

While tests the condition and if it is True then it 
proceeds to execute the statements inside the loop.  
While loops are preferred over For loops when the 
number of iterations is unknown, e.g. modelling how 
many days it takes to reach sales a target or running 
through a worksheet column until it reaches an 
empty cell.

Let’s consider an example: Jack and Jill go up a hill, but 
they might go tumbling down at any point.  Assume 
the probability of falling down with any step is 30% 
and independent of any steps previously taken. Let’s 
model how many steps it takes for them to fall down.  
What needs to be done?

 • take a step
 • assess the probability if they have fallen down  
  or not
 • repeat if they haven’t.

Visual Basics
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Notice how our condition is tested first.  This means that the code will not run at all if the condition is not met.  FallenDown is a Boolean value, whilst 
the While statement may be used as the condition.

While FallenDown

...

Wend

This is equivalent to saying:

While FallenDown = True

...

Wend

FallenDown was initially set to be False.  Using FallenDown as the condition for the loop would mean that Jack and Jill would never set foot on the hill.

While Wend loops are a remnant from the BASIC programming language and remains as a form of backwards compatibility.  Using a Do...Loop statement 
is usually preferred.  Loop back next newsletter to explore why these are considered superior to While Wend.

More next time.

The ability to create lookup columns in Excel is very useful, especially when 
we have a table that only contains an identifier of some sort but the data 
we need, such as the product name, is stored elsewhere.  For example, 

let’s assume that we have the following table that contains shipment data 
for some arbitrary given date: 

Yes, the table is useful however the table only contains the Product ID and Customer ID, making this particularly difficult to read for those of us who 
don’t know product and customer IDs off the top of our heads.  In this instance, the customer and product names are stored in other (related) tables, viz.

We can use the RELATED function to create two custom columns in the shipment table that will display the Product Name and Customer Name.  
You should note that before creating the custom columns, ensure that the three tables have been loaded to the data model and have established 
relationships between them.

We continue our series on the Excel COM add-in, Power Pivot.  This month, we consider how to create lookups in Power Pivot.

Power Pivot Principles
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To create our custom columns, navigate to the Power Pivot window and create a custom column on our Shipping table:

It’s simple: 

=RELATED(‘Customer Table’[CustomerName]).

We add another column for the Product Name:

=RELATED(‘Product Table’[ProductName]).

There we have it, using the RELATED function we have created a much more readable table. 

More Power Pivot Principles next month.
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For this month’s article, the easiest way to explain what we’re trying to achieve is with a ‘before and after’ example.  Let’s start with this:

Here, we have a simple table showing us our imaginary salespeople, and the benefits they have access to.  However, instead of the x’s, let’s say we 
wish to put the name of the benefit into the table, so that we end up with this:

This is then much easier to manipulate and merge with other tables.  Therefore, we’re going to look at a way to achieve this on a small scale, by 
adding new columns.  Next month, we will look at a more complex version that will work for any number of columns. 

Thus, to commence we’ll create a query using ‘From Table’ on the ‘Get and Transform’ section of the ‘Data’ tab:

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at 
a simple method to convert a check box into a name.

Power Query Pointers
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We will use the ‘Add Column from Examples’ on the ‘Add Column’ tab.

Let’s provide ourselves with the option of using any column, and we’ll start typing what we would like to see in a new version of the Car column, viz.

It’s important to keep an eye on the formula at the top of the screen:

Transform if [Name] = ‘Derek’ then ‘Car’ else if [Name] = ‘Mary’ then null else null

This is clearly not what we want so let’s enter another example:
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This is what we’re looking for:

Transform if [#”Car”] = “x” then “Car” else if [#”Car”] = null then null else null

This is replacing our x’s with ‘Car’.  We may then either add all our columns in this way or else use ‘Conditional Column’ and use the same idea for 
our other columns.  An example of this alternative approach is shown below:

Having added all four new columns, we have the desired format:

We may then delete our original columns from the Home tab using the ‘Remove Columns’ option.
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We then rename the columns and ‘Close & Load’ the data to the Excel worksheet.

This is fine if we have four columns, but what if there are hundreds?  Also, whilst this query may be refreshed if new employees join the company, 
what if new benefits were introduced?  Next month, we’ll show a different method which will work for any number of columns…

So as we say, more next month!

This month’s updates see the announcement of a variety of new features such as the conditional formatting for data labels, the new ‘Select sensitivity 
label’ dialog, a data loss prevention policy update and DAX Editor improvements.  The full list is as follows:

Power BI Updates

Reporting

	 •	 Conditional	formatting	for	data	labels
	 •	New	‘Select	sensitivity	label’	dialog
	 •	Data	loss	prevention	policy	update
	 •	Metric	visual
	 •	Mobile	formatting	now	supports	text	box	visuals

Modelling

	 •	DAX	Editor	improvements

Data connectivity and preparation

	 •	MariaDB	(Connector	Update)
	 •	Google	Sheets	(Connector	Update)
	 •	 Certified	connectors	availability	in	Power	BI	dataflows	and		
	 	 datamarts

Mobile applications

	 •	 Follow	metrics	from	your	mobile	application

Developers

	 •	 Introducing	a	new	way	to	manage,	enforce	and	transact	licences		
	 	 for	Power	BI	visuals

Visualisations

	 •	New	visuals	in	AppSource
	 •	Drill	Down	Combo	Bar	PRO	by	ZoomCharts
	 •	 Inforiver	charts

Other

	 •	Visualising	views	in	Dynamics	365	with	Power	BI	General	Availability
	 •	More	ways	to	optimise	Power	BI	performance.

Let’s now go through each in turn.

When conditional formatting for data labels was first introduced to 
Power BI Desktop last year, the scope at which Power BI evaluated your 
conditional formatting rules was based upon the full aggregate of the 
field across the whole visual, rather than at each data point.  This caused 
all data labels in the visual to come out to the same colour.  This was not 
exactly a crowd favourite, and it has been amended with this update.

With this update, conditional formatting on data labels for visuals with 
one or more measures and no field in the Legend field well will now 
evaluate for data points.  The example (below) shows data labels for 
sales from this year coloured blue if sales grew above a certain threshold 
over last year, else red if they did not:

Conditional formatting for data labels
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You can find the conditional formatting options for these labels in the 
Formatting pane, under Data labels -> Values -> Color.  You may set 
conditional formatting rules for all measures or for individual measures.  
Formatting set on individual measures takes precedence.  Therefore, if 
you’ve explicitly set a colour for data labels on all measures and add a 
conditional formatting rule for just one, the conditional formatting rule 
will apply to that measure.

It should be noted that conditional formatting rules for data labels that 
you’ve set on current reports already will be unaffected.  This is good 
for preserving backward compatibility, but not so good necessarily for 
getting the per-datapoint “correct” behaviour out to authors.  You can 
get this new behaviour simply by editing your report on this version of 
Power BI and reapplying the colour conditional formatting rule onto your 
relevant data labels.

In an upcoming release, Microsoft has stated that they will bring this 
same behaviour to visuals where you also have a field in the Legend 
field well.  The company has admitted they have discovered a critical 
bug preventing them from shipping the whole feature this month, so 
they decided to compromise in order to get one half of it out early.  In 
anticipation of the rest of this update, Power BI has removed conditional 
formatting button from the Formatting pane for data labels in cases 
where you have a measure grouped by a legend field.  This has been 
modified to prevent more users from setting up the “wrong” conditional 
formatting rules.

More very soon.

For tenants requiring sensitivity labels on their reports, Power BI now 
allows creators to set the sensitivity label directly from the save flow.  
Previously, the dialog would produce a message re-directing the user to 

find and use the Ribbon dropdown instead.  This new dialog helps save 
creators time searching for the sensitivity labels settings in the Ribbon to 
complete their save.

New ‘Select sensitivity label’ dialog
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Earlier this year, Microsoft Purview DLP policies were released for Power 
BI into public Preview.  These DLP policies enable you to better control 
the sensitive information managed in your Power BI tenant, as well as 
comply with governmental or industry regulations, such as GDPR (the 
European Union’s General Data Protection Regulation).

This month, the ability for Power BI users to provide feedback on the 
policy rules evaluating their datasets has been introduced.  In the 
dataset’s Detail page, you will now be able to see all the policy rules that 
have been detected for this dataset.  A side panel will appear with a card 
representing each and every rule.  On top of viewing all the matched 
rules, data owners will be able to take action if they believe the data was 
falsely identified.

Based upon how the policy rule was configured, you will be able to see 
one or a combination of these actions:

 • Report an issue: report the issue as a false positive (meaning that  
  the policy has mistakenly identified non-sensitive data as sensitive,  
  for example)

 • Override: override the policy.  Overriding a policy means that this  
  policy will no longer evaluate this particular dataset.  Depending  
  upon the policy configuration, you may be required to provide a  
  justification for the override

 • Report and override: report the issue as a false positive and  
  override the policy.

These tools have been provided to Power BI users so that they may 
provide insight on the datasets met with rules defined by the Security 
Admins in Microsoft Purview Compliance Portal and help create a built-
in line of communication to ensure smooth operation on both teams.

The Metric visual is now available in Power BI Desktop.  This visual provides a considerable level of flexibility in integrating metrics into your Power 
BI reporting solutions.  You may now include individual metrics instead of the entire scorecard and create report pages showcasing metrics alongside 
other visuals, in the context of the rest of the report data.

Data loss prevention policy update

Metric visual
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You may either create a new metric or add a metric from an existing scorecard as a visual in the report.

You can create a metric by either entering values or connecting to data in reports you have access to.

You can view notes, perform check-ins and set up rules on this metric similar to the methodologies required on a regular scorecard.  Furthermore, 
you may also format the metric visual to the look and feel of the rest of the report and it is configurable with options to turn the individual metric 
elements (such as targets, owner etc.) on / off.

In this release, mobile formatting has been extended to support text box visuals.  Now, when you add a text box to the mobile canvas, you can change 
its Format settings to best suit the mobile-optimised view you’re creating.

Mobile formatting now supports text box visuals
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In this update, Microsoft has commented that they “…have been working hard on improving the DAX editing experience after [they] changed some 
core components at the end of last year”.  With this update, they have announced that they have now fixed the most common issues and welcome 
any feedback – positive and / or negative.

The MariaDB connector has been updated to resolve customer-reported bugs.

The Google Sheets connector has been updated to include a direct link to Google Sheets documentation.

Now you can follow metrics directly from the mobile application and keep up to date with the activity on those metrics.  To start following a metric, 
just tap ‘More options’ (…) on a metric’s card in the Metrics hub or in the metric’s Details pane and choose ‘Follow metric’.

80+ additional data sources (all certified connectors) are now available in the Power Query Online experience for use in Power BI dataflows and 
datamarts.  This means that Power BI dataflows and datamarts creators have the option to connect to many more data sources in Power Query 
Online experiences, similar to Power BI Desktop today.

Notable additions include:

•	 Anaplan
•	 Asana
•	 Azure	Databricks	and	Databricks
•	 Denodo

•	 Dremio
•	 Google	Sheets
•	 HexagonSmartAPI
•	 MariaDB

•	 Palantir	Foundry
•	 Planview	Projectplace
•	 Starburst	Enterprise
•	 SurveyMonkey.

DAX Editor improvements

MariaDB (Connector Update)

Google Sheets (Connector Update)

Follow metrics from your mobile application

Certified connectors availability in Power BI dataflows and datamarts
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To view all the metrics you’re following, select ‘Following’ in the Metrics 
display list, accessible from the Metrics hub.  It makes no difference 
whether the metric was marked for ‘Following’ in the Power BI Service 

or in the mobile application; you will see them all.  Likewise, in the Power 
BI Service you’ll also be able to see all your followed metrics, including 
those that you started following from the mobile app.

Microsoft recently announced a key feature for AppSource visuals: it is 
now possible to sell, manage and enforce licences directly through the 
commercial marketplace.  Developers may use the new licencing API, 

available with API version 4.7 and July release of Power BI Desktop, 
to enforce the licence and provide a unique standardised licencing 
experience for end users.

Drill Down Combo Bar PRO offers a wide selection of customisation 
options, letting creators build a large selection of charts from a single 
custom visual.  You can build everything from regular Bar charts to Box 

and Whisker plots.  This visual also offers powerful cross-chart filtering 
capabilities combined with intuitive on-chart interactions.

The following are new visuals this update:

 • Video by CloudScope
 • Video Pro by CloudScope
 • Collage NextGen by CloudScope

	 •	 Collage	Pro	by	CloudScope;
	 •	 Inforiver	Charts	by	Inforiver.

Introducing a new way to manage, enforce and transact licences for Power BI visuals

Drill Down Combo Bar PRO by ZoomCharts

New visuals in AppSource
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Main features include:

 • multiple chart types: choose between Column, Line and Area charts
 • full customisation: customise x and y axes, the legend, stacks, clusters, ToolTips, outline and fill settings
 • stacking and clustering: choose normal, 100% proportional or zero-based stacking
 • customise series: up to 25 may be customised
 • static and dynamic thresholds: set up to four [4] thresholds to demonstrate targets or benchmarks
 • conditional formatting: take customisation to the next level 
 • use series defaults and value labels defaults: to customise multiple series simultaneously
 • ToolTip field support: now available
 • multi-touch device friendly: get the same experience on mouse and touch input devices.

You may try Drill Down Combo Bar PRO now by downloading the visual from AppSource.

Key highlights:

 • performance management visualisations for both comparative and non-comparative measures with integrated variances in a single click.   
  Variances for the prior year, budget and forecast data are calculated automatically
 • exploratory analysis with contextual drill-down, drill-up and drill-across navigation across multiple dimensions
 • storytelling and data-point annotations to tell compelling stories using dynamic data-level annotations.  This supports small-multiples and  
  flexible text orientation
 • advanced small multiples / Trellis to analyse across various data categories in a single click with highly responsive layouts, context-based  
  titles, analytics and comments
 • integrated KPI Cards with multiple conditional formatted KPI Metrics, benchmarks and variances
 • rich feature set which includes mostly frequently requested capabilities in Power BI Idea place and Power BI user community, such as:
   o measure-driven data labels
   o Stacked Waterfall chart
   o Gradient Line chart.

Inforiver is certified by International Business Communication Standards (IBCS) and is available in AppSource to try and buy.

Inforiver charts is a quick way to explore, visualise and share performance management insights in Power BI. Using 40+ advanced visualisation 
options, users may build data stories in minutes and share actionable performance insights through an intuitive no-code user experience (UX).

Inforiver charts
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This update includes the announcement that the Power BI integration 
in Dynamics 365 and model driven Power Apps, which shipped as a 
Preview last December, is now Generally Available.  Dynamics 365 and 
model driven Power Apps give organisations the ability to quickly build 
essential line-of-business apps in a low-code environment, increasing 
agility and modernizing processes.  

Since these apps are all built on top of Dataverse, they’re backed by your 
core business data. With this integration directly on views, information 
workers are now able to tap into this data and explore it using Power 
BI’s powerful data analytics capabilities without ever needing to leave 
their app.  All you have to do is click the ‘Visualize this view’ button and 
let Power BI automatically create a report on top of the exact data you 
were looking at.

Recently, settings were introduced in Power BI Desktop that allowed 
optimisation of Power Query query execution performance.  This month, 
new settings have been added to influence the Power BI engine query 
execution further.  Together, these settings enable you to optimise the 

performance of Power BI whilst data is being imported or DirectQuery 
queries are being executed.  For example, in case data import is taking 
too long or DirectQuery queries are slow or slowing down source 
systems, these settings can help you optimise performance.

	 •	 Search	for	fields	in	the	PivotTable	Field	List
	 •	 Power	Query	Group	operations	are	now	available

	 •	 Control	automatic	data	conversions	(Insiders	Beta)
	 •	Natural	Language	Query	improvements	(Current	Channel	and	Monthly	Enterprise	Channel)

	 •	Natural	Language	Query	improvements
	 •	Resizable	Conditional	Formatting	dialog	(Insiders	Beta).

Let’s	plough	through.

Microsoft is rolling out an update to the PivotTable Field List in Excel for the web to enable users to easily search for fields in their PivotTables.  If you 
don't see this feature yet, don’t worry, it’s on its way!

That’s it for this month.  See you in October!

Visualising views in Dynamics 365 with Power BI General Availability

More ways to optimise Power BI performance.

Excel for the web

Excel for Windows

Excel for Mac

Seach for fields in the PivotTable Field List

Aside from Excel Live (please see earlier in this newsletter), there are other additions / improvements to Excel this month too.  These updates are 
as follows:

New Features for Excel
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Power Query has been further enabled in Excel for the web this month, with the advent of Group operations to the Queries pane.  This will allow you 
to better sort your queries and perform various operations on query groups.

	 •	 Select	the	top-level	button	and	then	choose	‘New	group’

	 •	Give	the	new	group	a	name;	you	can	also	enter	a	description	should	you	wish
	 •	When	you	are	done,	choose	Save

	 •	 You	will	see	the	new	group	was	created:

You should note that until you move queries into groups, all queries will be listed under the ‘Other queries’ group.

This new functionality is available to all Office 365 Subscribers on Excel for the Web.

You can now perform various operations on Power Query groups to better organise your queries and easily consume the data on the Queries pane.  
To begin, open the Queries pane, select the Data tab and then choose Queries.

Power Query Group operations are now available

Create a new group
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	 •	 Select	the	top-level	button	and	then	choose	‘Expand	all’	/	‘Collapse	all’	as	required

	 •	 If	the	group	contains	queries,	you	can	refresh	all	of	them	at	once,	the	same	way	you	can	refresh	individual	queries
	 •	 To	do	this,	select	the	action	menu	button	and	then	choose	Refresh.

	 •	 If	you	want	to	reorganise	your	queries	and	take	them	out	of	the	group,	you	can	use	this	operation
	 •	 To	do	this,	select	the	action	menu	button	and	then	choose	Ungroup

	 •	 To	do	this,	select	the	action	menu	button	and	then	choose	Rename

	 •	 Enter	the	new	name,	then	press	anywhere	to	save	changes.

You should note that this action will only delete the group, not the queries in this group.

Obviously, Refresh will work for supported data sources only.

	 •	 You	will	see	the	result	of	the	respective	action	in	the	Queries	pane.

Again,	you	should	note	that	you	can	Expand	or	Collapse	any	group	by	using	the	arrow	next	to	the	group	name.

Expand / collapse all groups

Refresh a group

Ungroup the queries within a group

To rename a group
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	 •	 To	do	this,	select	the	action	menu	button	and	then	choose	‘Delete	group’.

	 •	 To	do	this,	select	the	action	menu	button	and	then	choose	‘Move	to	group…’

	 •	 If	a	group	is	nested	within	one	or	more	groups,	you	can	quickly	move	it	to	the	top	level
	 •	 To	do	this,	select	the	action	menu	button	and	then	choose	‘Move	to	top	level’.

	 •	 Select	the	item	you	want	to	move	it	to	and	then	select	Save.

At this stage, delete is supported for empty groups only.  Microsoft has stated it is working on adding support for deleting groups that include queries.

To delete a group

Move a query or group into another group

Move a group to the top level
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	 •	 To	do	this,	select	the	action	menu	button	and	then	choose	Properties

	 •	 You	can	use	this	to	rename	the	group	or	change	its	description
	 •	When	you	are	done,	select	Save

	 •	 You	will	be	able	to	see	the	group	description	by	hovering	over	it.

Apparently, Microsoft’s future plans include Query operations, amongst other ideas.  The end goal is to release the full Power Query Editor experience 
to Excel for the Web eventually.

Edit a group’s properties
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This improvement to Excel for Windows will give you more control over 
data conversions.  Specifically, you may now control how and whether 
the data you enter is automatically converted to specific formats.

It’s no secret that many have been frustrated by the fact that Excel 
automatically converts data to specific formats.  End users have 
continually expressed a desire for more control over data conversions.

Whilst Microsoft has emphasised that they will not change the Excel 
defaults, Excel will now provide the ability to disable specific types of 

automatic data conversions as needed.  This way, you won’t need to 
worry about your data being converted to a format that you didn’t want 
and weren’t expecting.

To disable specific automatic data conversions, select File -> Options -> 
Advanced- > Automatic Data Conversion.  Then choose the conversion(s) 
that you’d like to disable.

The latest natural language processing innovations have now been 
released to Excel for Windows.  You can now ask questions about specific 
patterns or insights that might be in your data like "Show me insights for 
Southeast Asia".  This will include receiving more options when there are 
multiple answers to your question.

This is all part of ‘Analyze Data’ in Excel which empowers you to 
understand your data through natural language queries that allow you 
to ask questions about your data without having to write complicated 
formulae.  In addition, ‘Analyze Data’ provides high-level visual 
summaries, trends and patterns.

All you have to do is select a cell in a data range and select the ‘Analyze 
Data’ button on the Home tab of the Ribbon.  ‘Analyze Data’ in Excel 

will analyse your data, and return interesting visuals about it in the 
associated task pane.

If you're interested in more specific information, you can enter a question 
in the query box at the top of the pane, and press ENTER.  ‘Analyze Data’ 
will provide answers with visuals such as tables, charts or PivotTables 
that can then be inserted into the workbook. 

If you are interested in exploring your data, or just want to know what is 
possible, ‘Analyze Data’ also provides personalised suggested questions 
which you can access by selecting on the query box.  You simply select 
the text box at the top of the ‘Analyze Data’ pane and you will see 
suggestions:

Currently, you may enable or disable the following options:

 • remove leading zeros from numerical text and convert to a number
 • truncate numerical data to 15 digits of precision and convert to a number that may be displayed in scientific notation, if needed
 • convert numerical data surrounding the letter “E” to a number displayed in scientific notation.

Presently, there are a couple of known issues:
 • support for disabling these conversions during macro execution is planned but is not yet available
 • support for automatic conversion to dates is planned but, again, is not yet available.

This feature is available to Office Insiders running Version 2207 (Build 15427.20000) or later on Windows.  The same options should come to Excel 
for Mac soon.

You should also note that you may select the ‘When loading a .csv file or 
similar file, notify me of any automatic number conversions’ check box.  
By doing so, Excel will display a warning message when it detects that 

at least one of the optional automatic data conversions is enabled and 
about to occur when opening a .csv or .txt file.  The message gives the 
ability to do a “one-time load” of the file without converting the data.

Control automatic data conversions (Insiders Beta)

Natural Language Query improvements (Current Channel and Monthly Enterprise Channel)
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Alternatively, you may just ask a question:

If you do not have a question in mind, in addition to Natural Language, 
‘Analyze Data’ analyses and provides high-level visual summaries, trends 
and patterns.  You can save time and get a more focused analysis by 
selecting only the fields you want to see. When you choose fields and 
how to summarise them, ‘Analyze Data’ excludes other available 

data - speeding up the process and presenting fewer, more targeted 
suggestions.  For example, you might only want to see the sum of sales 
by year or you could ask ‘Analyze Data’ to display average sales by year.

 • Select ‘Which fields interest you the most?’
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	 •	 Select	the	fields	and	how	their	data	should	be	summarised

	 •	Analyze	Data’	will	offer	fewer,	better	targeted	suggestions.

You should note that the ‘Not a value’ option in the field list refers to 
fields that are not normally summed or averaged.  For example, you 
wouldn't sum the years displayed, but you might sum the values of 

the years displayed.  If used with another field that is summed or 
averaged, ‘Not a value’ works like a row label, but if used by itself, 
‘Not a value’ counts unique values of the selected field

To make the most of ‘Analyze Data’, it’s best to work with clean, tabular data, viz.
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Here are some tips for getting the most out of ‘Analyze Data’:

 • ‘Analyze Data’ works best with data that is formatted as an Excel table.  To create an Excel table, click anywhere in your data and then go to  
  Insert -> Table (CTRL + T)
 • make sure you have good headers for the columns.  Headers should be a single row of unique, non-blank labels for each column.  Avoid  
  double rows of headers, merged cells, etc.
 • if you have complicated, or nested data, you can use Power Query to convert tables with cross-tabs or multiple rows of headers.

As above!!

Previously, the size of the ‘Manage Rules’ dialog in Excel for Mac limited 
you to viewing just five [5] conditional formatting rules at a time.  You 
may also not be able to see the entire formula or the range used in your 
rules.  Now, you can make the dialog wider and / or taller, allowing you 

to see more of the rules all at once and giving you more space to view 
longer formulas if needed.

In addition, this update improves accessibility by making it easier to use 
your keyboard to manage your conditional formatting rules.

Microsoft has released an ‘Excel Features Availability’ flyer to detail all of these items:

You can find the updated version of this grid with the interactive links at aka.ms/ExcelFeaturesFlyer. 

Natural Language Query improvements (Excel for Mac)

Resizable Conditional Formatting dialog (Insiders Beta)
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An imaginary number is a complex number that can be written as a real 
number multiplied by the imaginary unit i (sometimes denoted j) which 
is defined by its property i2 = −1.  In general, the square of an imaginary 
number bi is −b2.  For example, 9i is an imaginary number, and its square 
is −81.  Zero is considered to be both real and imaginary. 

An imaginary number bi can be added to a real number a to form a 
complex number of the form a + bi, where the real numbers a and b are 

called, respectively, the real part and the imaginary part of the complex 
number.

The polar form of a complex number is another way to represent the 
number.  The form z = a + bi is called the rectangular form of a complex 
number.

The horizontal axis is the real axis and the vertical axis is the imaginary axis.  You can find the real and imaginary components in terms of r and θ, 
where r is the length of the vector and θ is the angle made with the real axis.

From the Pythagorean Theorem,

r2 = a2 + b2

By using the basic trigonometric ratios,

cos θ = a / r and sin θ = b / r

Therefore, multiplying each side by r:

r cos θ = a and r sin θ = b

Therefore, 

z = a + bi

 z = r cos θ + (r sin θ)i

 z = r(cos θ + i sin θ)

In the case of a complex number, r represents the absolute value, or modulus (where r = |z| = , and the angle θ is called the argument of 
the complex number

  
for a > 0 and

 
for a < 0).

Using Euler’s Formula,

The A to Z of Excel Functions: IMSQRT
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It is using this approach that the square root of the complex number x + yi may be determined:

where:

The IMSQRT function returns the square root of a complex number in x + yi or x + yj text format.  It employs the following syntax to operate:

IMSQRT(inumber)

The IMSQRT function has the following argument:

 • inumber: this is required and represents the complex number for which you want to calculate the square root.

It should be further noted that: 

 • you should use COMPLEX to convert real and imaginary coefficients into a complex number
 • IMSQRT recognises either the i or j notation
 • if inumber is a value that is not in the x + yi or x + yj text format, IMSQRT returns the #NUM! error value
 • if inumber is a logical value, IMSQRT returns the #VALUE! error value
 • if the complex number ends in +i or -i (or j), i.e. there is no coefficient between the operator and the imaginary unit, there must be no space,  
  otherwise IMSQRT will return an #NUM! error.

Please see our first example below: 

and

The A to Z of Excel Functions: IMSUB
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Sometimes you might wish to subtract one complex number from another.  IMSUB returns the difference of two complex numbers in the x + yi or  
x + yj text format.  

The IMSUB function employs the following syntax to operate:

IMSUB(inumber1, inumber2)

The IMSUB function has the following arguments:

 • inumber1: the first argument and represents the number from which to subtract number2
 • inumber2: this is also required.  This is the complex number to subtract from inumber1.

It should be further noted that: 

 • you should use COMPLEX to convert real and imaginary coefficients into a complex number
 • IMSUB recognises either the i or j notation
 • if any of inumber1 or inumber2 is a value that is not in the x + yi or x + yj text format, IMSUB returns the #NUM! error value
 • if any of inumber1 or inumber2 is a logical value, IMSUB returns the #VALUE! error value
 • if any of inumber1 or inumber2 is non-numeric, IMSUB returns the #VALUE! error value
 • if any complex number ends in +i or -i (or j), i.e. there is no coefficient between the operator and the imaginary unit, there must be no space,  
  otherwise IMSUB will return an #NUM! error

• the difference of two complex numbers is given by:

Feeling contrary having read about IMSUB, you might wish to add one complex number to one or more other complex numbers.  IMSUM returns the 
sum of two or more complex numbers in the x + yi or x + yj text format.  

The IMSUM function employs the following syntax to operate:

IMSUM(inumber1, [inumber2], …)

The IMSUM function has the following arguments:

 • inumber1, [inumber2], …: inumber1 is required; other arguments are optional.  Between 1 and 255 complex numbers may be added together.

Please see an example below: 

The A to Z of Excel Functions: IMSUM
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It should be further noted that: 

 • you should use COMPLEX to convert real and imaginary coefficients into a complex number
 • IMSUM recognises either the i or j notation
 • if any of inumber1, [inumber2], … is a value that is not in the x + yi or x + yj text format, IMSUM returns the #NUM! error value
 • if any of inumber1, [inumber2], … is a logical value, IMSUM returns the #VALUE! error value
 • if any of inumber1, [inumber2], … is non-numeric, IMSUM returns the #VALUE! error value
 • if any complex number ends in +i or -i (or j), i.e. there is no coefficient between the operator and the imaginary unit, there must be no space,  
  otherwise IMSUM will return an #NUM! error
 • the addition of two complex numbers is given by:

Please see an illustration below: 

Similar to real trigonometric identities, , where z = a + bi.  

The IMTAN function returns the tangent of a complex number in x + yi or x + yj text format.

The IMTAN function employs the following syntax to operate:

IMTAN(inumber)

The IMTAN function has the following argument:

 • inumber: this is required and represents the complex number for which you want to calculate the tangent.

It should be further noted that: 

 • you should use COMPLEX to convert real and imaginary coefficients into a complex number
 • IMTAN recognises either the i or j notation
 • if inumber is a value that is not in the x + yi or x + yj text format, IMTAN returns the #NUM! error value
 • if inumber is a logical value, IMTAN returns the #VALUE! error value
 • if the complex number ends in +i or -i (or j), i.e. there is no coefficient between the operator and the imaginary unit, there must be no space,  
  otherwise IMTAN will return an #NUM! error.

Please see our final example for this month below: 

More Excel Functions next month.

The A to Z of Excel Functions: IMTAN
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Our solution to this newsletter’s challenge uses a function most of you may never even have considered, or perhaps didn’t even know existed…

Beat the Boredom Suggested Solution

“All” I wanted to do was be able to take a text string and split it up so that each element of text was split into a separate column formulaically, e.g.

It’s not impossible to come up with some monstrous calculation using a combination of text functions.  Some of you may have worked out some 
horrendous formula that appears to work.  I applaud you if you have.

But I am going to go another way; what about this little beauty?

Until Excel 2013, Excel was mostly an offline application, although you could use VBA, Power Query / Get & Transform or Power Pivot in Excel to gain 
access to internet and online datasets.  However, Excel 2013 changed all that and introduced two new functions to the world:

 1. WEBSERVICE, which provides immediate and easy access to any REST WebAPI assuming you have an internet connection by downloading the  
  HTTP response of the provided URL;  and 

 2. FILTERXML, which parses an XML string (i.e. a text string that contains an XML document) and returns a single element (known as a node or  
  attribute) provided by an XPath.  In case you are wondering, XPath is a query language for selecting XML elements such as nodes and attributes  
  and works with both XML and HTML.

Therefore, FILTERXML tends to work in tandem with WEBSERVICE insofar that it makes sense of the long text string delivered by the former function 
and finds what you are looking for in that text string. 

The FILTERXML function employs the following syntax to operate:

FILTERXML(xml, xpath)

The FILTERXML function has the following arguments:

 • xml: this is required and represents a string in a valid XML format
 • xpath: this is also required. This represents a string in a standard XPath format.

For the formula in cell G13:

=TRANSPOSE(FILTERXML("<x><y>"&SUBSTITUTE(E13,",","</y><y>")&"</y></x>","//y"))

Er, what the..?  

Maybe (!) this needs some explanation.  Let’s start with the highly popular and frequently used FILTERXML function.  Hands up all those who use this 
function regularly…

Note I have used different separators (delimiters) in the two examples displayed.  The fact I have used four elements each time is entirely coincidental.

The Challenge

Suggested Solution

The FILTERXML function
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It should be noted that:

 • if xml is not valid, FILTERXML returns the #VALUE! error value
 • if xml contains a namespace with a prefix that is not valid, FILTERXML returns the #VALUE! error
 • the FILTERXML function is not available in Excel Online
 • the FILTERXML function is not available in Excel (2016) for Mac
 • Further, this function may appear in the function gallery in Excel for Mac, but it relies on features of the Windows operating system, so it will  
  not return results on a Mac.

Here are some examples: 

OK, so far so good.  But there is another function used…

The SUBSTITUTE function, like the REPLACE function, replaces existing text with new text in text strings.  It uses the following syntax to operate:
SUBSTITUTE(text, old_text, new_text, instance_number)

where:

 • the text parameter is the string of text that contains the characters that we want to substitute
 • the old_text parameter is the string of text that we want the function to look for in the text parameter
 • the new_text parameter is the text string that is going to replace the old_text
 • the instance_number is the instance which we want the old_text to be replaced by the new_text parameter if there are multiple old_text  
  strings found.  If excluded, all occurrences are replaced.

It is a simple to understand function.

For the formula in cell G13:
=TRANSPOSE(FILTERXML("<x><y>"&SUBSTITUTE(E13,",","</y><y>")&"</y></x>","//y"))

Let’s review the first argument of FILTERXML for cell G13:

"<x><y>"&SUBSTITUTE(E13,",","</y><y>")&"</y></x>"

Revisiting our example:

The SUBSTITUTE function

Returning to Our Suggested Solution
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If we calculated this, we would get

<x><y>alpha</y><y>beta</y><y>gamma</y><y>delta</y></x>

Oh now, it’s completely clear (!).  

Do you see that the text alpha,beta,gamma,delta has had the comma substituted for </y><y>, and then this has been “wrapped” inside

<x><y>…</y></x>

If you are familiar with XML or even HTML, you might be starting to see where this is all going.  Consider these angular bracket elements:

 • <x> and </x> denote the start and end of the data x (you can replace x with pretty much any text string)

 • <y> and </y> denote the start and end of a y “node”, i.e. a building block of XML.  Again, you can change y to an alternative annotation.  The  
  overarching idea is that an entire document is a document node; every element in a documane is an element node; text in an element is a  
  text node, etc.  We have y nodes!

Therefore, we have broken the text string up into its text nodes.  Therefore,

=FILTERXML(expression, “//y”)

means parse (split up) each y node.  This will provide a list of the y nodes.  If you are using a version of Excel that supports dynamic arrays, you would 
get the following:

Wrapping this function in TRANSPOSE swaps rows to columns and vice 
versa.  However, also this could be performed using “legacy” Excel where 
dynamic arrays are not recognised by selecting several cells once you 
have created the formula and pressing CTRL + SHIFT + ENTER.

It’s a little different, but this month shows you how sometimes you 
can use functions meant for something else completely and use them 
in an entirely different environment.  We doubt anyone at Redmond 
envisaged this trick back when this function was coded!

Until next time.

 

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.

Location Course Date Date Duration Duration

Online (Australia) Power Pivot, Power Query and Power BI 28 -30 Sep 2022 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 5 Oct 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 1 Day

Online (Australia) Financial Modelling 6 - 7 Oct 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 2 Days
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
·  Business planning
·  Building three-way integrated   
	 financial	statement	projections
·  Independent expert reviews
·  Key driver analysis
·		 Model	reviews	/	audits	for	internal		 	
	 and	external	purposes
·		 M&A	work
·		 Model	scoping
·		 Power	BI,	Power	Query	&	Power	Pivot
·		 Project	finance
·		 Real	options	analysis
·		 Refinancing	/	restructuring
·		 Strategic	modelling
·		 Valuations
·		 Working	capital	management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, we look again at the CTRL 
and SHIFT keys, but this time combined with the function keys that Excel uses:
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Keystroke What it does

CTRL + SHIFT + F1 Show / hide Ribbon and Quick Access Toolbar altogether

CTRL + SHIFT + F3 Create names

CTRL + SHIFT + F4 Find previous (from most recent search)

CTRL + SHIFT + F6 Previous window / workbook

CTRL + SHIFT + F12 Print

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Location Course Date Date Duration Duration

Online (Australia) Power Pivot, Power Query and Power BI 9 - 11 Nov 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 16 Nov 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 1 Day

Online (Australia) Financial Modelling 17 - 18 Nov 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 7 - 9 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 14 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 1 Day

Online (Australia) Financial Modelling 15 - 16 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 2 Days


